
Experiment NB-7: Crustacean 
Stretch Receptor

Background
Animals use their senses to gather information about 

their environment. Most senses use specialized sensory 
organs (eyes, ears, nares) to receive stimuli. These 
organs vary widely between species, In turn, the infor-
mation received by the sensory organ is coded in the 
impulses generated by sensory neurons and conducted 
to the animal’s central nervous system for the generation 
of an appropriate response.

The stretch receptors in the tails of decapods (shrimp, 
lobsters, crayfish) are good examples of sensory organs 
that are integrated with sensory neurons which are 
connected to a central nerve chord. These receptors 
monitor the position and movement of the animal’s tail, 
particularly important if the animal has to make a hasty 
retreat. The nerve tracts from these receptors are easily 
exposed, allowing recording electrodes to be attached to 
the nerves without damaging the sensory organs or the 
muscles that are being monitored. 

Students will record responses from two different types 
of stretch receptors that are positioned next to the dorsal 
superficial extensor muscles in the tail of the crayfish. 
Each type of sensory organ responds to a different 
stimulus, generates impulses of a different amplitude 
and frequency, and adapts to prolonged stimuli at a 
different rate.

The Stretch Receptor
To have the fine degree of neuromuscular control 

needed for coordinated movements, an animal’s nervous 
system needs to monitor the positions of its body parts 
at all times. Position and tension in skeletal muscle is 
often monitored by a sensory organ known as a muscle 
receptor organ (MRO) that lays in parallel with the 
skeletal muscle. A muscle receptor organ is composed 
of a receptor muscle (RM) and a sensory neuron (SN). 
The dendrites of the sensory neuron are embedded in 
the receptor muscle and are stimulated when the 
receptor muscle is stretched. The receptor muscle 
stretches as the skeletal muscle does. The stretch-
sensitive dendrites of the sensory neuron have ion 
channels that open and produce graded potentials in 
response to the stretching of the receptor muscle. When 
the graded potentials of the sensory neuron sum to 
reach its threshold, an action potential develops and 
propagates along the sensory neuron to its synapse with 
the central nervous system.

When a decapod curls its tail quickly and repeatedly to 
move backwards, a process known as scuttling, the 
ventral flexor muscles alternate contractions with the 

dorsal extensor muscles in a fraction of a second. As the 
flexors contract, the extensors on the dorsal relax and 
stretch, In turn, the muscle receptor organs on the 
extensors stretch and the associated sensory neurons 
generate action potentials. These are the action poten-
tials that will be recorded in this experiment as the tail of 
the crayfish is flexed.

As the dorsal extensor muscles in the crayfish tail 
contract, their receptor muscles must also contract. If a 
receptor muscle does not contract, it and the dendrites 
of its attached sensory neuron are too slack to create 
the action potentials needed to monitor the position and 
movement of the animal’s tail. Receptor muscles have 
motor innervations and contractile elements just like 
other muscles. When tension is maintained in these 
receptor muscles, they and their sensory neurons are 
ready to create action potentials when stretched.

The Crayfish
The tail of a crayfish is composed of interlocking 

exoskeletal plates known as terga. Each abdominal 
segment, or tergum, and the two most posterior thoracic 
segments of a crayfish contain two types of muscle 
receptor organs (MRO) along the dorsal superficial 
extensor muscles. One type of MRO is a slow adapting, 
tonic, receptor (MRO1); and, the other type is a quick 
adapting, phasic, receptor (MRO2).

On each side of the dorsal midline, one of each type of 
MRO originates at the anterior edge of a segment and 
inserts at the anterior edge of the following segment 
(Figure NB-7-1 on page NB-7-1). So, when the tail flexes 
(curls) and the tail segments rotate around the lateral 
hinge joints that connect the adjacent terga, the dorsal 
receptor muscles stretch and the attached sensory 
neurons generate action potentials that can be recorded 
from the lateral nerve tract that is caught in a suction 
electrode. When the tail extends (straightens out), the 
receptor muscles are relaxed and the sensory neurons 
cease firing.

 Figure NB-7-1: Cut-away diagram (side view) of a segment of crayfish tail.
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Adaptation
Each receptor muscle (RM1 or RM2) is embedded with 

the dendrites of a its own sensory neuron (Figure NB-7-2 
on page NB-7-2). The axons from the sensory neurons 
of the MRO’s on the same side of a segment join 
together in a nerve that circles the major dorsal and 
ventral interior muscles of the tail on its track to the 
ventral nerve cord (Figure NB-7-1 on page NB-7-1). 
MRO’s lie on top of the medial superficial extensor 
muscles that line the inside dorsal surface of the crayfish 
tail. In turn, the deep medial flexor muscles of the tail lie 
over these receptor muscles. 

Each MRO also has an accessory nerve fiber that 
originates in the animal’s central nervous system, and its 
activity creates inhibitory post-synaptic potentials 
(IPSP’s) in the sensory neuron as the tail flexion ends 
and extension begins in preparation for another flexion. 
IPSP’s effectively raise the threshold of the sensory 
neuron, requiring a greater degree of dendritic stretching 
to create an action potential. 

The exercises in this experiment will demonstrate:

• the types of muscle receptor organs (MRO): MRO1, which is 
slow-adapting and discharges for long periods of time with a 
moderate, constant stretch; MRO2, which is fast-adapting and 
responds only briefly to sharp, vigorous stretching.

• adaptation, or a decrease in the frequency of firing, in the 
slow-adapting MRO as the time after the initiation of a constant 
stretch increases.

• the frequency of firing of MRO1 is directly proportional to the 
degree of tail flexion or stretching of RM1.

 Figure NB-7-2: RM sensory and inhibitory innervation. Motor innervation is 
omitted.

Equipment Required
PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

Model 3000 AC/DC extracellular differential amplifier

C-DB15-P3 Nerve bath recording cable

Suction electrode assembly and glass tips

Audio monitor

BNC T-connector

Stand and clamp, or micromanipulator, for electrode.

Plastic crayfish bath chamber

Dissection microscope and light source

Tissue tensioner, or micromanipulator, for flexing tail.

Faraday cage and steel base plate (if noise in room)

Cables and alligator clips for grounding equipment

Suture thread

Crayfish

Crayfish saline (See Appendix)

Pasteur pipettes and bulbs

Dissection tools

IWX/214 Setup
1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure NT-3-1 in the Tutorial chapter for the location 
of the USB port and the power socket on the IWX/214.

3 Check Figure NT-3-2 in the Tutorial chapter for a picture of 
the IWX/214 power supply.

4 Use the USB cable to connect the computer to the USB port 
on the rear panel of the IWX/214. 

5 Plug the power supply for the IWX/214 into the electrical 
outlet. Insert the plug on the end of the power supply cable 
into the labeled socket on the rear of the IWX/214. Use the 
power switch to turn on the unit. Confirm that the red power 
light is on.

Start the Software
1 Click on the LabScribe shortcut on the computer’s desktop 

to open the program. If a shortcut is not available, click on 
the Windows Start menu, move the cursor to All Programs 
and then to the listing for iWorx. Select LabScribe from the 
iWorx submenu. The LabScribe Main window will appear 
as the program opens.

2 On the Main window, pull down the Settings menu and 
select Load Group.

3 Locate the folder that contains the settings group, 
INBLMV1.iwxgrp. Select this group and click Open.
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4 Pull down the Settings menu again. Select the Crustacean 
SR-NBK settings file.

5 After a short time, LabScribe will appear on the computer 
screen as configured by the CrustaceanSR-NBK settings.

6 For your information, the settings used to configure the 
LabScribe software and the IWX/214 unit for this exper-
iment are listed in Table NB-7-1 on page NB-7-3. These 
settings are programmed on the Preferences Dialog 
window which can be viewed by selecting Preferences 
from the Edit menu on the LabScribe Main window.

Model 3000 Amplifier and Audio Monitor Setup
1 Place the Model 3000 AC/DC extracellular amplifier (Figure 

NB-7-3 on page NB-7-3) and its AC power supply on the 
bench near the IWX/214.

 Figure NB-7-3: The front panel of the Model 3000.

2 Place a T-connector (BNC) on the Channel 1 BNC 
Input of the IWX/214.

3 Use a BNC-BNC cable to connect the BNC output of the 
Model 3000 to an open end of the T-connector (BNC) on the 
Channel 1 BNC input of the IWX/214.

4 Attach the BNC connector on the input cable of the audio 
monitor to the remaining open end of the T-connector on 
Channel 1 BNC input of the IWX/214.

Warning: Before connecting the input cable to the probe 
input of the Model 3000, turn off the Model 3000 amplifier

5 Locate the C-DB15-P3 recording cable (Figure NB-7-4 on 
page NB-7-3) in the NBK/214 kit. Attach the DB15 
connector on the end of the cable to the DB-15 probe 
socket of the Model 3000 amplifier.

 Figure NB-7-4: The C-DB15-P3 recording cable.

6 Attach the three connectors of the suction electrode 
assembly to the matching connectors of the C-DB15-P3 
recording cable so that:

• the recording electrode, which is the wire inside the lumen of 
the suction tubing, is connected to the black (+) connector.

• the indifferent (reference) electrode, which is the wire 
wrapped around the suction tubing down to the glass micro-
electrode tip, is connected to white (-) connector.

• the ground electrode, that is in the solution in the bath 
chamber, is connected to the green (driven shield) 
connector.Place the barrel of the suction electrode on a micro-
manipulator placed close the crayfish preparation dish.

7 Place the barrel of the suction electrode on a micromanipu-
lator placed close the crayfish preparation dish.

Table NB-7-1: Settings on the Channel Window 
of the Preferences Dialog that Configure the 
iWorx System for Experiment AN-2.

Parameter Uni ts/Ti t le Sett ing Mode/
Funct ion

Acquis i t ion Mode Chart

Start User

Stop User

Display Time Sec 5

Speed Samples/Sec 10000

Channel  A1 MRO Potent ia ls S BNC

Channel  C1 MRO Fir ing Freq. S P.Freq.

Table NB-7-2: Settings on the Model 3000 
Amplif ier for Recording MRO Potentials.

Funct ion Sett ing

HIGH PASS FILTER (Hz) 1

NOTCH FILTER OFF

LOW PASS FILTER (kHz) 10

CAPACITANCE COMPENSATION Counterclockwise

COARSE DC OFFSET Midrange

FINE DC OFFSET Midrange

DC OFFSET OFF

INPUT MODE DIFF

GAIN 100

RESISTANCE (Ω )  TEST OFF

MODE REC
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8 Place the knobs and switches on the front of the Model 
3000 amplifier in positions that configure the amplifier for 
this experiment. The settings used on the Model 3000 for 
this experiment are listed in Table NB-7-2 on page NB-7-3.

Note: The filter settings listed in this table are suggested for 
use in ideal recording conditions. If noise is present in the 
recording environment, the high and low pass filters can be set 
at different levels to create a recording with less noise. If noise 
is caused by AC line voltage used to power the equipment in 
the lab, the notch filter can be used.

9 Plug the output of the AC power supply into the power input 
on the back of the Model 3000 amplifier. Plug the power 
cord of the AC power supply into the electrical outlet. 

10 Flip the power switch of the Model 3000 to the ON position 
and allow the amplifier to warm up for 5 minutes. 

Electrical Noise 
Electrical noise is the most common problem 

associated with the recording of bioelectric signals. It 
radiates through the air and comes from electrical 
devices in the lab room or building: lights, power outlets, 
computers, monitors, and the power supplies. Since the 
source of power for these devices is 60Hz alternating 
current (AC), this electrical noise appears as a distorted 
sine wave with a repeating period of 16.7 milliseconds 
(msec).

There are two major sources of electrical noise: 
pickup and ground loops.

Pickup
Pickup is caused by electrical radiation that produces 

currents in the electrodes and wires leading to the ampli-
fiers in the recording system. Because the resistance in 
the electrodes is high, small currents produce large 
voltages that may be greater than the biopotential being 
recorded. The major ways to reduce pickup are:

• Faraday Cage: Put a grounded, screened enclosure, known 
as a Faraday cage, around the preparation and the electrodes. 
the enclosure separates the source of the radiation from the 
electrodes. The person operating the equipment might also be 
a source of noise, and he or she may need to be grounded.

• Shielded Cables: Use shielded cables to carry the signals 
from the electrodes to the amplifier and the recorder; this puts 
a protective ground around the wires carrying the bioelectric 
signal. 

• Differential Recording: Record using both a positive and a 
negative recording electrode placed on the nerve. The noise 
signals that are equal in magnitude, but opposite in polarity, will 
cancel each other out and leave a flat baseline. 

• Short Cables: Use the shortest cables available to reduce 
the length of wiring exposed to electrical noise.

• Direct Current Equipment: Use equipment, like preampli-
fiers and illuminators, that are powered by batteries or direct 
current (DC) transformers.

• Equipment Removal: Unplug or remove unused alternating 
current (AC) equipment from the area.

Ground Loops
Ground loops are a troublesome source of electrical 

noise caused by the ground cable itself serving as an 
antenna for the noise radiating in the room. Using a 
Faraday cage to shield the preparation and the recording 
electrodes does not remove the electrical noise caused 
by ground loops. To avoid ground loops, use the 
following techniques:

• Ground Hub: Ground all the equipment around the prepa-
ration to a common grounding point (hub). This includes all the 
items that are electrically powered or are made of metal, like 
illuminators or microscopes. Use simple cables, like banana 
cords equipped with alligator clips, to connect each device 
directly to the common grounding point. The common ground 
point is connected to the ground of the recording device with a 
single cable. The recording device is connected to the building 
ground.

• Simple Chain: Ground the devices to the common 
grounding point using the simplest route that links the first 
device to the second device, the second device to the third 
device, and so on. Start the chain at the device that is the 
farthest from the common grounding point. End the chain by 
connecting the last device to the common grounding point, 
which is connected to the ground of the recording device.

• Free-Floating: In addition to using one of the grounding 
techniques described earlier, plug all devices powered by alter-
nating current (AC), like illuminators, amplifiers, and recording 
units to power outlets using three-two prong adapters.

High Frequency Noise
High frequency noise can also be a problem when 

recording bioelectric potentials. This type of noise is 
seen as the thickening of the recorded line. This noise 
contains many frequencies, and the amplitude of the 
noise is proportional to the resistance of the electrode. 
Therefore, intracellular electrodes, with high resistances, 
pick up a greater amplitude of high frequency noise than 
extracellular electrodes, with low resistances.

Mechanical Noise
Mechanical noise, like vibrations from the ventilation 

system in the room, can cause the electrodes to vibrate 
and produce voltage changes with each vibration cycle. 
To alleviate this problem, isolate the platform holding the 
preparation with foam pads or bicycle inner tubes. Also, 
avoid bumping the table when the recording electrodes 
are in place.

Grounding
The Model 3000 amplifier has two different connec-

tions for grounding:

• One method uses the driven shield on the input cable as 
described earlier.

• The other method uses the ground (GND) input of the Model 
3000. 
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1 Try recording when the ground electrode in the prep dish is 
connected to the green wire lead on the input cable. 

2 If the recordings have a lot of 60Hz noise while using the 
driven shield of the input cable, connect the ground 
electrode to the ground input of the Model 3000 amplifier.

Warning: Never connect the driven shield to the ground 
(GND) input of the Model 3000, either directly or indirectly.

3 If the recordings still have a lot of 60Hz noise, connect the 
ground electrode to one of the green ground inputs of the 
iWorx 214 unit.

Signal Improvement
1 To improve recordings of the stretch receptor potentials, 

move the prep dish away from sources of 60Hz noise. 
These sources include outlets, computers, monitors, lights, 
refrigerators, water baths, and other AC powered devices

2 Noise can be decreased by changing the settings of the 
High and Low Pass Filters, or using the Notch Filter, on 
the Model 3000. If the new settings alter the shape of the 
action potential, they cannot be used.

3 Noise can also be decreased by applying the digital filter 
function in the LabScribe 2 software to the data. Click on the 
add function button in the upper margin of the Compound 
Action Potential channel. Select Filter from the menu of 
computed functions.

4 In the Filter Setup Dialog window, the Filter Mode is set 
to the Hamming Window and the Filter Order is set to 51. 
These are the default settings that should be used.

5 Set the Low Cutoff filter value to 65 and the High Cutoff 
filter value to 8000. The filter cutoffs can be set by:

• Typing the values for the filter cutoffs in the boxes to the right 
of the names of the filter cutoffs.

• Clicking on the up or down arrows to the right of the boxes 
displaying the values of the filter cutoffs.

• Clicking on the margins of the colored area in the graphic 
display of the filter and dragging the margins to the values 
required.

The Dissection
1 Place a crayfish in icewater for 10 minutes. Remove the 

crayfish from the icewater and quickly cut off its head.

2 Remove the tail from the thorax by cutting around the joint 
(seam) connecting those two parts.

3 Observe the hinge ridge that runs along each side of the 
tail; only cut on the ventral side of the hinge ridge in order to 
preserve the hinges that hold the segments of the tail 
together,. 

4 Hold the tail and make a longitudinal cut along each side tail 
(below the hinge ridge) to loosen the ventral shell, 
swimmerets, and flexor muscles from the dorsal shell. 

Leave the tail fins attached to the dorsal exoskeleton.

5 Begin at the anterior end of the tail and separate the ventral 
and dorsal halves of the shell from each other. It may be 
necessary to cut (use small forceps) the connections of that 
the segmental flexor muscles make to the dorsal shell.

6 Discard the ventral portion of the shell (Figure NB-7-5 on 
page NB-7-5). 

 Figure NB-7-5: Diagram to show the dissection of the crayfish tail.

7 Place the dorsal shell in the preparation dish and quickly fill 
the dish with crayfish saline.

8 Push one pin through the shell in the first abdominal 
segment and a second pin through the telson.

9 Place the dish under the dissection microscope, position the 
light for optimal illumination and focus on the preparation. 
Use small forceps to remove the gut (the green tube in the 
midline) and any connective tissue from the prep.

10 Examine the preparation, compare with Figure NB-7-6 on 
page NB-7-5 and identify:

• The six abdominal segments.

• The paired fast extensor muscles in each segment—one 
muscle group on either side of the mid-line.

• The medial and two lateral bundles in the fast extensor 
muscle group on each side of a segment. 

 Figure NB-7-6: Ventral aspect of the second abdominal segment of crayfish. 
Dorsal musculature removed on the right side and intact on the left side.
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11 Poke a hole through the most posterior segment (telson) 
and then thread a suture through this hole. Tie the suture to 
the tail using a loose loop. The exoskeleton in this area is 
very thin and tears very easily if knots are tied too tightly.

12 Gently pulling on the string should flex or curl the tail. If the 
hinge ridge has been damaged, the tail will not flex 
correctly.

13 Examine the cut edges of the exoskeleton with a dissecting 
microscope. Locate any cut ends of nerves containing the 
axons of sensory neurons, extensor motor fibers, and other 
sensory fibers. Usually the nerve ends float free of other 
tissue near the posterior and lateral wall of each tergum.

14 With fine forceps, carefully remove any large segments of 
damaged flexor muscles that obscure the viewing of nerves 
or interfere with the placement and operation of the suction 
electrode.

Placement of the Electrode
1 Place the chamber containing the crayfish on the table (or 

steel grounding plate inside a Faraday cage, if necessary).

2 Position the dissecting microscope over the preparation 
chamber and focus on the nerve trunks along the edge of 
the exoskeleton.

3 Place the coiled ground electrode over the side of the 
specimen chamber, using wax or clay to hold it in place. The 
copper wire in the lead and the solder joint holding the silver 
electrodes to the leads must not touch the saline bath.

4 Place two micromanipulators at the end of the chamber 
nearest the most anterior segment of the tail. Attach the 
extracellular suction electrode to one of the micromanipu-
lators.

5 Locate a nerve from which to record and grossly position 
the electrode near the nerve. Pin down the segment in 
which the nerve is located. Avoid injuring the MRO's or the 
nerves by pinning along the midline or well to the sides.

6 Align the electrode and its manipulator (or stand and clamp) 
at an angle that still permits the posterior segments of the 
tail to be flexed without touching the electrode. View the 
electrode tip through the microscope and move it until it is 
near or touching the cut end of the nerve. The opening in 
the tip of the electrode should be the same size or only 
slightly larger than the diameter of the nerve. Carefully pull 
back on the plunger of the 3cc syringe (without moving the 
tubing) and pull the end (or a loop) of the nerve into the 
electrode. 

7 Check the height of the saline in the chamber and inside the 
glass microelectrode. Both the positive and negative 
electrodes should be in contact with the saline since the 
amplifier of the recording channel is used to record differen-
tially between the inner and outer wires. 

8 Position another micromanipulator (or tissue tensioner) on 
the end of the bath with the anterior tail segments. Attach 
the suture on the telson to the horizontal axis of this device, 
so the suture does not interfere with the recording electrode 
when the tail is flexed by movement of the horizontal axis of 

the micromanipulator or tensioner.

Exercise 1: MRO1
Aim: To record action potentials from the slow-adapting 

MRO1.

1 Click Record on the LabScribe Main window to begin 
recording. 

2 Type MRO1 in the Mark box to the right of the Mark 
button. Press the Enter key on the keyboard to attach this 
notation regarding the type of receptor potentials to be 
recorded.

3 Move the horizontal axis of the micromanipulator holding 
the suture on the telson and flex the crayfish tail to a 
position where the MRO1 begins firing slowly. 

4 Click the AutoScale button on the MRO Potential and 
MRO Firing Frequency channels to adjust the size of the 
traces displayed on the Main window. 

5 Note the readings on the scale of the horizontal axis of the 
manipulator or the number of turns of the tensioner required 
to create this MRO1 firing frequency. A slow-adapting MRO1 
should generate action potentials, like the ones with a low 
amplitude and high frequency in Figure NB-7-7 on page NB-
7-6.

 Figure NB-7-7: The action potentials from MRO1 (with their lower amplitude 
and higher frequency) and MRO2 (with their higher amplitude and lower 
frequency) are displayed on the upper channel. The frequency of action poten-
tials from MRO2 are displayed on the lower channel. 

6 Move the horizontal axis of the micromanipulator or 
tensioner to flex the tail to a greater degree. The frequency 
of firing from MRO1 should increase.

7 Move the horizontal axis of the micromanipulator or 
tensioner to flex the tail to an even greater degree. The 
frequency of firing from MRO1 should be increase, again.

8 Click Stop to halt the recording. Note the readings on the 
scale of the horizontal axis of the manipulator rack. The tail 
may then be returned to the same degree of flexion in order 
to verify the measurements.Relax the tail from its flexed 
state between recordings to conserve neural activity. 
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9 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file, like your lab group folder). Designate the file type as 
*.iwxdata. Click on the Save button to save the data file.

Exercise 2: MRO2
Aim: To record action potentials from the fast-adapting 

MRO2.

1 Click Record. Move the horizontal axis of the micromanipu-
lator holding the suture on the telson and flex the crayfish 
tail to a position where the MRO1 is firing slowly. 

2 Type MRO2 in the Mark box to the right of the Mark 
button. Press the Enter key on the keyboard to attach this 
notation regarding the type of receptor potentials to be 
recorded.

3 Click the AutoScale button on the MRO Potential (CH3) 
and MRO Firing Frequency channels to adjust the size of 
the traces displayed on the Main window.

4 While recording action potentials from MRO1, use a pencil 
to tap the suture holding the tail in the flexed position. This 
tap should be quick, as if the pencil is bouncing off the 
suture. If the movement of the pencil depresses and holds 
the suture too deeply, the electrode could be pulled off the 
nerve or the nerve could be damaged. With this technique, 
MRO2 should generate a burst of larger action potentials in 
the midst of action potentials from MRO1, as in Figure NB-7-
7 on page NB-7-6.

5 Click Stop to halt the recording. Relax the tail from its flexed 
state between recordings to conserve neural activity. 

6 Select Save in the File menu to add this data to the current 
data file.

Questions
1 Were you able to elicit a response from the MRO2? if you 

did, what technique did you use?

2 Did you observe any differences between the responses of 
MRO1 and MRO2? Explain these differences.

Exercise 3: Adaptation of MRO1
Aim: Subject MRO1 to constant stretch and measure 

the decline in its rate of firing or adaptation.

Procedure
1 Click Record. Move the horizontal axis of the micromanipu-

lator holding the suture and flex the crayfish tail to a position 
where the MRO1 is firing rapidly. 

2 Type MRO1 Adaptation in the Mark box to the right of the 
Mark button. Press the Enter key on the keyboard to 
attach this notation regarding adaptation of the MRO1 firing 
rate

3 Click the AutoScale button on the MRO Potential and 
MRO Firing Frequency channels to adjust the size of the 
traces displayed on the Main window.

4 As you continue to record, press the Enter key on the 
keyboard every five seconds to place a mark on the 
recording. Continue recording for 2 minutes or until the 
MRO1 has stopped firing, whichever is shortest.

5 Click Stop to halt the recording. Relax the tail from its flexed 
state between recordings to conserve neural activity. 

6 Select Save in the File menu.

7 Repeat Steps 1 through 6 for a position where the MRO1 is 
firing less rapidly.

8 Repeat Steps 1 through 6 for a position where the MRO1 is 
firing even less rapidly.

Analysis
1 Scroll through the data file and locate the first recording of 

constant stretch on the muscle receptor organ.

2 Use the Display Time icons to adjust the Display Time of 
the Main window to display a fifteen-second section of 
recording on the Main window. This section of data can 
also be selected by:

• Placing the cursors on either side of the fifteen-second 
section of the recording, and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar (Figure NB-7-8 on page NB-7-7) to expand 
or contract the fifteen-second recording to the width of the 
Main window.

 Figure NB-7-8: The LabScribe toolbar.

3 Click on the Analysis window icon in the toolbar (Figure 
NB-7-8 on page NB-7-7) or select Analysis from the 
Windows menu to transfer the data displayed in the Main 
window to the Analysis window.

4 Look at the Function Table that is above the MRO 
Potential channel in the Analysis window. The mathe-
matical function, Mean, should appear in this table. The 
value for Mean firing frequency is displayed in the table 
across the top margin of the MRO Firing Frequency 
channel.

5 Once the cursors are placed in the correct positions for 
determining the mean frequency of MRO firing in this 
section of the recording, the value for Mean can be 
recorded in the on-line notebook of LabScribe by typing the 
names and values of the parameters directly into the 
Journal.

6 The functions in the channel menu of the Analysis 
window can also be used to enter the name and value of 
the voltage change from the recording to the Journal. To 
use these functions:

• Place the cursors at the location used to measure the mean 
firing frequency.
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• Transfer the names of the parameters to the Journal using 
the Add Title to Journal function in the MRO Firing 
Frequency channel menu.

• Transfer the values for the parameters to the Journal using 
the Add Ch. Data to Journal function in the MRO Firing 
Frequency channel menu.

7 On the MRO Firing Frequency channel displayed in the 
Analysis window, use the mouse to click on and drag the 
cursors so they are about five seconds apart.

8 Record the value for the mean firing frequency (Mean) in 
the Journal using the one of the techniques described in 
Steps 5 or 6.

9 Move the left (first) cursor to a point on the recording that is 
five seconds to the right of the position of the second cursor. 
Determine the frequency of firing in this five second block of 
time. Enter that value in the Journal.

10 Continue to move the cursor to successive five-second 
marks, determining the frequency of firing at each mark, 
and entering those values in the Journal. Continue until the 
end of the recording is reached. 

11 Repeat Steps 1 through 10 for the other two constant 
stretch recordings that started with lower initial firing 
frequencies.

Questions
1 Plot the frequency of firing of MRO1 in the first segment as a 

function of the time after the initiation of the constant 
stretch. Is the graph linear?

2 What can be concluded about the rate of adaptation of 
MRO1? How does the duration of the constant stretch affect 
the response of the MRO1?

3 Plot the frequency of firing of MRO1 in the third (slowest) 
segment as a function of the time after the initiation of the 
constant stretch. Is the relationship linear?

4 Can you make any conclusions about the degree of 
constant flexion and the rate of adaptation?

5 How might an animal benefit from adaptation?

Exercise 4: Flexion & Firing Frequency
Aim: Find the rate of MRO1 firing for different degrees 

of flexion in the crayfish tail.

Procedure
1 Make sure the pinned segment of the crayfish tail remains 

secure as this exercise is performed.

2 Click Record. Relax the crayfish tail to a position where the 
MRO1 is scarcely firing. Note the position of the index mark 
on the scale of the micromanipulator or the position of the 
tensioner. Click the AutoScale button on the MRO 
Potential channel to adjust the size of the trace. 

3 As the recording continues, quickly rack the manipulator, or 
tensioner, to increase the flexion of the crayfish tail by one 

scale unit, or a fraction of a turn. Press the Enter button on 
the keyboard to mark the recording as the final angle of 
flexion is reached. 

4 Record the firing of the MRO1 with the micromanipulator or 
tensioner in this position for a period of 5 seconds. Then, 
relax the crayfish tail to the starting position where the 
MRO1 was scarcely firing. 

5 If you are ready to flex the crayfish tail to a greater degree, 
continue recording. 

6 Quickly rack the micromanipulator or the tensioner with a 
greater degree of tail flexion (two scale units, or fractions of 
a turn), Mark the recording, and record the firing of the 
MRO1 in this position for 5 seconds. Note the position of the 
index on the scale of the micromanipulator or the turns of 
the tensioner. Relax the crayfish tail to the starting position 
as done in Step 4.

7 Repeat Steps 3 and 4 three more times with flexions equal 
to 3, 4, and 5 scale units, or fractions of a turn.

8 Click Stop to halt the recording. Relax the tail from its flexed 
state to conserve neural activity. 

9 Select Save in the File menu.

Data Analysis
Use the same techniques used in Exercise 3 to 

measure the frequency of MRO1 firing at different 
degrees of tail flexion. 

Questions
1 Plot the initial firing frequency of MRO1 at each degree of 

tail flexion as a function of the degree of tail flexion 
(expressed in units of movement for the micromanipulator 
or tensioner).

2 What is the relationship between the degree of flexion and 
the initial frequency of firing? Is the relationship linear?

3 Does MRO1 respond to any and all degrees of flexion? Why 
or why not?
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Appendices

Extracellular Suction Electrode
1 Obtain the following items to make your own suction 

electrode (Figure NB-7-9 on page NB-7-9): a soldering iron; 
solder; a wire stripper; a wooden-handled dissecting pin; an 
alcohol burner; a can or tube of contact or plastic cement; a 
fine flat file; emery cloth; electrical tape; a popsicle stick; two 
pieces of chlorided silver wire (0.005” dia, 5” long); three 
feet of shielded, two-conductor, insulated cable; three color-
coded connectors that will mate to the connectors on the 
input cable for the amplifier; three feet of flexible plastic 
tubing (20 gauge Tygon or PE 100); an 18-gauge needle, a 
3-way stop cock, a 3cc syringe, a 1cc tuberculin syringe; 
glass micropipette tip.

2 Connectors and electrodes need to be attached to the ends 
of the shielded, two-conductor cable. Take one end of the 
cable and carefully strip 5 inches of insulation off the end. 
Minimize the number of strands of braided shielding cut 
during the removal of the insulation. Avoid cutting the 
conductor wires under the braided shielding.

3 Unbraid the 5 inches of exposed shielding. Pull the 
conductor wires aside. Gather all the strands of the 
shielding in a bundle and twist them together. Solder a small 
alligator clip to the end of the twisted shielding.

4 Strip a quarter of an inch of insulation off the end of each 
conductor wire. Solder a piece of the chlorided silver wire to 
the end of each wire.

5 Take the other end of the cable and carefully strip 3 inches 
of insulation off the end. Again, minimize the number of 
strands of braided shielding cut during the removal of the 
insulation. Avoid cutting the conductor wires under the 
braided shielding.

6 Unbraid the 3 inches of exposed shielding. Pull the 
conductor wires aside. Gather all the strands of the 
shielding in a bundle and twist them together. Solder a 
color-coded connector, that mates with the connector on the 
input cable of the amplifier, to the end of the twisted 
shielding. Since the shielding is the ground wire, the 
connector is usually color-coded green.

7 Strip a quarter of an inch of insulation off the end of each 
conductor wire at this end of the cable. Solder a color-coded 
connector to the end of the each conductor wire. A red 
connector is usually put on the wire conducting the signal 
from the recording electrode. On this suction electrode 
assembly, the recording electrode will be the silver wire that 
is inside the lumen of the suction tubing. A black connector 
is usually put on the wire connected to the indifferent or 
reference electrode, which is a silver wire wrapped around 
the outside of the electrode tip.

 Figure NB-7-9: Typical suction electrode assembly.

8 Heat the tip of the dissecting pin in the flame of the alcohol 
burner. Use the heated tip to poke a small hole in the side of 
the plastic tubing that is about 3 inches from the end of the 
tubing and angled toward the end at 45 degrees.

9 Remove the plunger from the 1cc tuberculin syringe. Find 
the end of the plastic tubing without the hole. Push this end 
of the tubing through the hole in the front end of the 1cc 
syringe barrel until the tube exits the rear of the syringe 
barrel. Push and pull the tubing through the syringe barrel 
until the small angled hole in the side of the tube is about 
half of an inch from the front of the syringe barrel.

10 Find the silver electrode that is designated as the recording 
electrode by being color-coded to the red conductor wire or 
connector. Push the tip of this electrode wire through the 
hole in the side of the plastic tubing. Keep the solder joint of

the electrode to the conductor wire about a quarter of 
an inch away from the hole in the tubing. 

11 Mix up the contact or plastic cement. Use the popsicle stick 
to place a drop of cement over the hole in the tubing to 
create an air-tight seal around the silver electrode wire 
going through the hole. Make sure the cement does not drip 
into the lumen of the tubing and block it. Contact and plastic 
cement usually dries to the touch in 10 to 15 minutes.

12 Once the hole is sealed, cut the end of the silver recording 
electrode so that a quarter of an inch of the wire is sticking 
out of the end of the tubing.

13 Use the flat file and emery cloth to remove the point and 
smooth the tip of the 18-gauge needle. Once smoothed, 
push the tip of the needle into the other end of the plastic 
tubing.
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14 Attach the 3-way stopcock to the 18 gauge needle, and the 
3cc syringe to the 3-way stopcock.

15 When the nerve has been isolated, determine the diameter 
of the tip of the glass micropipette needed to fit the nerve. 
Snap the tip of the micropipette at the correct diameter, and 
fire-polish the tip to remove and jagged edges.

16 Place the glass micropipette over the wire sticking out the 
end of the plastic tubing. Push the micropipette into the 
plastic tubing to make a tight seal. The silver wire should be 
sticking a short distance into the glass micropipette. 

17 The silver wire that is the indifferent or reference electrode 
is wrapped around the outside of glass micropipette and 
part of the plastic tubing supporting the micropipette. The tip 
of the indifferent electrode should be as close as possible to 
the tip of the glass micropipette, but, the positive and 
negative electrodes and their connectors must not touch 
each other!

Chloriding Silver Wire
1 Obtain the following items to chloride your own silver wire: a 

9V transistor battery; a 9V transistor battery connector with 
color coded lead wires; two small alligator clips; a 200 ml 
beaker; 175 ml of 3M KCl; 1 roll of silver wire (0.005” dia); a 
#2 pencil; dental wax or clay; forceps

2 Attach an alligator clip to the each lead of the 9V transistor 
battery connector.

3 Pour the 3MKCl solution into the beaker.

4 Wrap a length of the silver wire around the pencil to form a 
coil of ten turns. At one end of the coil, there should be a 
straight segment about 1.5” long. Make two coils for each 
chloriding session.

5 Put two 1” long beads of dental wax or clay on opposite 
sides of the rim of the beaker.

6 Attach a coil of silver wire to each lead of the battery 
connector by clamping the straight segment of the wire in 
the jaws of the alligator clip.

7 Position each alligator clip in the wax or clay on opposite 
sides of the rim of the beaker, so that the two wire coils are 
in solution (Figure NB-7-10 on page NB-7-10).

 Figure NB-7-10: Setup used to chloride silver wire.

Warning: It is important that one wire coil does not touch 
the other, and that the alligator clips or the lead wires of 
the battery connector are not in solution!

8 Attach the 9V transistor battery to the battery connector. 
The solution near the coils will bubble and the coils will 
change color during the chloriding procedure. Chloride the 
coils for 8 minutes.

9 Disconnect the 9V battery from the connector. Reverse the 
chloriding process by putting each coil of silver wire on the 
other alligator clip. Use the forceps to hold a coil as it is 
removed from an alligator clip and moved to the other.

10 Re-position the alligator clips on the wax and the wire coils 
in the solution. Attach the 9V battery to the connector and 
chloride the wire coils in this polarity for another 8 minutes.

11 At the end of the second 8-minute period of chloriding. Put 
the wire coils back on the alligator clips to which they were 
initially attached and chloride the coils in this configuration 
for 5 minutes.

12 Finally, reverse the chloriding of the coils, as performed in 
Steps 9 and 10, for 5 minutes. At the end of the 5 minutes, 
disconnect the battery, remove the wire coils from the clips, 
and rinse the coils with deionized water.

13 The coils of chlorided silver wire are now ready to be used 
as electrodes.
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